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FEATURE SUMMARY 

The Uplinx Report Tool for Cisco Unified Communications is s comprehensive report tool solution to generate automatically 

configuration and phone inventory reports in no time.  

¶ Reports for Cisco Unified Communication Manager (6 to 8)  

¶ Reports for Cisco CUPS  (6 to 8)  

¶ Reports for Cisco Unity Connection 2.1 (Cisco suite 6), 7.0 and 7.1 , 8.x 

¶ Reports for Cisco Emergency Reporter 2 (Cisco suite 6), 7.0 and 8.x 

¶ Reports for Cisco Unified Contact Center Express (UCCX) 8.x 

¶ Reports for Microsoft Exchange with Unified Messaging role 

¶ Phone Inventory Tool: Collect serial numbers and location (connected switch name and port)  

¶ Comparison reports for CUCM configuration reports and Phone Inventory reports 

¶ Reporting objects can be selected and further specified based on filter criteria 

¶ generate Word, Excel, CSV, HTML, CHM (Compressed HTML Help) reports based on your own customizable Word and CSS 

templates 

¶ 4 word templates provided for professional WORD report generation 

¶ Chapter descriptions (fully customizable) 

¶ Option to defer reformatting in Word to reduce time on site  

¶ Command Line mode to allow for batch and scripted usage 

¶ Support for NAT and firewall 

¶ All server passwords are stored encrypted  

SYSTEM REQUIREMENTS 

¶ Cisco Unified Communications Manager (6, 7, 8), Presence Server (6, 7, 8), Unity Connection (2.1(6), 7, 8), Cisco Unified 

Contact Center Express (UCCX) 8.x, Cisco Emergency Responder CER version 2, 7 and 8 

¶ PC 32-bit or 64 -bit, recommended 4 GB RAM, i5 CPU or better (depending on amount of phones and database size) 

¶ Windows Seven, Windows Vista, Windows XP SP2/SP3, Windows Server 2003 and 2008 with .Net 4.0 (client or full)  

¶ (optional) Microsoft Word 2007 or Word 2010 (32 or 64 bit) to generate Word reports; VBA macros need to be installed and 

enabled 

¶ Web Browser  (IE 7 or later, Mozilla Firefox 3 or later, - other CSS 2 compliant browsers) 

¶ LAN connection from the PC where the Report Tool is run on to the servers (it works also via VPN or any other IP 

connectivity as long as there is decent quality. Bandwidth must be at least 150 Kbps and max 200ms RTT. Please test the 

VPN QoS first with the trial version before purchasing a license). 

SUPPORTED CISCO PRODUCTS AND SOFTWARE VERSIONS 

Uplinx Report Tool supports automatic generation of reports for the following Cisco UC software: 

Cisco Unified Communications Server: Versions supported: Reports generated for: 

Cisco Unified Communications Manager (CUCM) 6.0, 6.1, 7.0, 7.1 , 8.0, 8.5, 8.6 Configuration Reports  

Phone Inventory reports 

Cisco Unified Presence Server (CUPS) 6.0, 7.1, 8.0, 8.5, 8.6 Configuration Reports 

Cisco Unity Connection (CUC) 2.1 (6.1), 7.0, 7.1 , 8.0, 8.5, 8.6 Configuration Reports 

Cisco Emergency Reporter (CER) 2, 7 and 8, 8.5 Configuration, state and audit reports  

Cisco Unified Contact Center Express (UCCX)  8.x Configuration Reports and script 

documentation 

Microsoft Exchange - Unified Messaging role  2007 R2 and 2010 Microsoft Exchange with Unified 

Messaging objects and users 
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Note: Callmanager 4.1 and Cisco Unified Communications Manager 4.1, 4.2 and 4.3 are supported in CCMreporter 4. 

SUPPORTED PHONES IN PHONE INVENTORY TOOL 

¶ 794x, 796x, 797x (SCCP) and associated G versions with Expansion Module 7914/7915/7916 

¶ 7937 conference phones (SCCP) 

¶ WLAN phones 7920, 7921 and 7925, 7926 (SCCP) 

¶ ATA 186 (SCCP), ATA 187 (SIP) 

¶ 7902, 7905, 7906, 7911, 7912, 7931 (SCCP) 

¶ 8941, 8961 (SIP) 

¶ 9951, 9971 (SIP) 

¶ 69xx 

¶ 39xx 

Note: Phones must have web server enabled and run SCCP/SIP protocol as indicated above. 

REPORTS: MISSING CONFIGURATION OBJECTS  

All configuration objects are included except the following:  

¶ Cisco Emergency Reporter (CER): Licensing 

¶ Unity Connection: Cluster 

Unless noted, these objects cannot be included as access to them is not possible by the current system architecture. To achieve a full 

report it is required to copy these few objects into the generated Word report.  
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INSTALLATION 

After installing the Uplinx Report Tool please consider the following tasks in order to maximize the report tool capabilities. 

The Report Tool requires Microsoft .NET Framework 4.0 (client or full/server). When installing on Windows server 2003 or 

XP, it also requires .NET Framework 2 SP1 or .NET Framework 3.5. 

INSTALL SUPPORT FOR VBA MACROS IN MICROSOFT WORD  

If you plan to generate Word reports, Word macros need to be installed.  

Start > Settings > Control Panel > Programs and Features > Select  Office and select Change. In the installations options select óVisual 

Basic for Applicationsô and click continue. 

 

ENABLING VBA MACROS IN MICROSOFT WORD  

If you plan to generate Word reports, Word macros need to be enabled.  

Word 2007:  

VBA macros need to be enabled and VBA needs to be installed in Word 2007 to automatically generate word reports. 

To install VBA support: Start > Settings > Control Panel > Program and Features -- then select óOffice 2007ô and click óChangeô. In the 

installer select óChangeô and in the component 'Office Shared Features' enable 'Visual Basic for Applications'. 

Word 2010 : 

To enable VBA Macro support for Word 2010: 

File > Help > Options > Trust Center > Macro Settings > Select óEnable all Macrosô 
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Please enable the option ódisable all macrosô after all reports have been generated. 

VERIFYING VBA AND MACRO SUPPORT IN WORD  

In the Report Tool on the tab Report Settings click the button ôTemplate Settingsô in the Report Format section on the left hand side of 

the page. Click any one of the óGenerate Test Reportô buttons on the right hand site to test the support of VBA and Macros even 

without a server. A synthetic report with similar Macros as the original report will be generated.  

INSTALLING ODBC DRIVER FOR CISCO UNITY CONNECTION 

If you plan to generate reports for Cisco Unity Connection, the IBM ODBC driver for Informix is required. Do not install any ODBC 

driver that you find on the web. If you have already an IBM  ODBC driver installer, uninstall any ODBC drivers, reboot and follow the 

install procedure as outlined here. 

After you have installed the Uplinx Report Tool, run the Report Tool and click on the server tab.  

1.) Disable UAC (this is an IBM driver recommendation), else the IBM driver installer might not work.  

2.) Click on the óDownload ODBC driverô button to download the driver:  
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FAILED TO INSTALL ODBC DRIVER ON 64-BIT 

While installing the IBM ODBC driver, you might get the following error message:  

 

To resolve this, disable UAC (this is an IBM driver requirement ), reboot and retry . To disable UAC go to Start > Control and 

search for UAC and pull the slider to ñNever notifyò. Reboot and install the ODBC driver. 
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After the driver has been installed, click on óCheck for driverô in the Report Tool. Please note that to connect to Unity Connection the 

ODBC Proxy service in the Unity Connection Serviceability needs to be started. Please refer to óATTACHMENT A: CISCO UNITY 

CONNECTION: DETAILED INSTRUCTIONS TO ENABLE DATABASE ACCESSô on page 35. 

If it does not work, reboot the PC. 

After installation, enable UAC again. 

Troubleshooting:  

Check the log file for entries about the ODBC issue after pressing the ñCheck ODBC driverò button on the server tab. 

If the IBM ODBC driver is not recognized by the Report Tool after the recommended ODBC driver has been installed and the PC 

rebooted, it might be a privilege issue of the logged in user to access the following registry hive (directory):  

If  Not  Is64Bit Then '  = 32 bit OS  
                rootpath = "SOFTWARE\ ODBC\ ODBCINST.INI" 
            Else  '64 b it OS  
                rootpath = "SOFTWARE\ Wow6432Node\ ODBC\ ODBCINST.INI" 
            End If  

There are now 2 options to fix privilege issues:  

1.) Allow read and write access to the currently logged in user to órootpathô with regedit.exe  

2.) Use ñRun as administratorò of the Report Tool. To do so, right click on the Report Tool icon on the desktop and 

select ñRun as administratorò:  
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INSTALLING CISCO UCCX EDITOR FOR CISCO UNIFIED CONTACT CENTER EXPRESS 

If you plan to generate reports for Cisco UCCX that includes the UCCX scripts (.aef), the installation of Cisco UCCX Editor is required. 

To install it, login into the UCCX Web Admin page and download and install the editor from the plug -in page. 

INSTALLING CISCO UCCX SCRIPT EDITOR FOR CISCO UNIFIED CONTACT CENTER EXPRESS 

If you plan to generate reports for Cisco UCCX that includes the UCCX scripts (.aef), the installation of Cisco UCCX Editor is required. 

To install it, login into the UCCX Web Admin page and download and install the editor from the plug -in page. Run it and browse the 

script repository to make sure that the UCCX Editor works. 
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USER GUIDE 

The following steps outline how to generate a configuration report. For a phone inventory report, please see the next 

ŎƘŀǇǘŜǊ ΨHow to generate a Phone Inventory ReportΩ ƻƴ ǇΦ 26. 

HOW TO GENERATE A CONFIGURATION REPORT 

A report is generated in 3 steps:  

¶ Step 1: Set the access credentials to the server and verify connectivity 

¶ Step 2: Set the desired report content a nd report settings 

¶ Step 3: Generate the report 

Each of the steps is outlined in detail below.  

For detailed steps and options of the Phone Inventory report, please see ñPhone Inventory reportò on p.12. 

STEP 1: SET SERVER ACCESS CREDENTIALS AND VERIFY CONNECTIVITY 

 

Figure 1: Set the credentials to access the server 
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In the tab óServerô set the server credentials. Verify connectivity with the validate button. If you are directly connected to the servers 

(without firewall and no PAT) le aving the TCP port empty or setting it to ( -1) will use the correct TCP ports. If you use PAT, please see 

Attachment E ñSECURITY, FIREWALL AND NETWORK ADDRESS TRANSLATION (NAT)ò. 

You need to set up the following users, depending on the server type:  

CISCO UNIFIED COMMUNICATIONS MANAGER (CUCM) 

On CUCM an application user with the AXL SOAP privileges needs to be created and the AXL SOAP service needs to 

be running in Cisco Serviceability. Note: By default all Users in the Administrative Group have access to AXL SOAP. 

Some report contents are retrieved via the Command Line SSH shell. You can choose to set the same user as for the 

AXL SOAP by ticking the tick box, or alternatively by explicitly configuring another user with administrative privileges 

for the SSH access.  

NOTE:  

¶ In order to generate Phone Inventory Reports, the application user must be a member of the group 

Ψ{ǘŀƴŘŀǊŘ //a !ŘƳƛƴ ¦ǎŜǊǎΩΦ ¢Ƙƛǎ ƛǎ ǊŜǉǳƛǊŜŘ ōȅ /L{/h ǘƻ ŀŎŎŜǎǎ ǘƘŜ wL{ ŎƻƳǇƻƴŜƴǘΦ 

¶ For configuration reports, the report tool user needs to have the AXL SOAP privilege assigned. 

CISCO UNIFIED PRESENCE SERVER (CUPS) 

On CUPS an application user with the AXL SOAP privileges needs to be created and the AXL SOAP service needs to 

be running in Cisco Serviceability. Note: By default all Users in the Administrative Group have access to AXL SOAP. 

Some report contents are retrieved via the Command Line SSH shell. You can choose to set the same user as for the 

AXL SOAP by ticking the tick box, or alternatively by explicitly configuring another user with administrative privileges 

for the SSH access.  

CISCO UNITY CONNECTION (CUC) 

On CUC the access is facilitated by Cisco via the ODBC Proxy Service on the Unity Connection server. The following 

needs to be created: 

1. Create a administrative user for access via the ODBC Proxy 

2. Enable the ODBC Proxy Service on CUC. tƭŜŀǎŜ ǎŜŜ Ψ Attachment A:  

Cisco Unity Connection: How to enable database accessΩ ƻƴ ǇŀƎŜ 51. 

3. Install the IBM ODB/ ŘǊƛǾŜǊΦ tƭŜŀǎŜ ǎŜŜ ΨInstalling ODBC driver for Cisco Unity ConnectionΩ ƻƴ ǇŀƎŜ 8. 

CISCO EMERGENCY REPORTER (CER)  

Cisco Emergency Reporter (CER) report contents are retrieved via the Command Line SSH shell. Please test the user 

credentials by logging into CER with a SSH terminal client.  

CISCO UNIFIED CONTACT CENTER EXPRESS (UCCX) 

Generating reports for UCCX version 8.0 and 8.5 is now available starting with Uplinx Report Tool version 8.5. 

Reports for Cisco Unified Contact Center Express (UCCX) 8.0 and 8.5 contain the following: 

Configuration reports of the UCCX administration pages in HTML, Word, CHM 

All reports may include the UCCX scripts (.aef). This requires that the Cisco UCCX Editor for the UCCX server version 

is installed on the same machine as the Report Tool. 

All UCCX scripts (.aef) are copied to the output folder 

If the following checkbox is ticked, the UCCX report includes the configuration of CTI ports of Call Control Groups 

and CTI Route Points of UCCX triggers: 
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If ticked, the CUCM credentials must be entered to retrieve CUCM configuration data. 

Requirements:  

To download the UCCX scripts (.aef) scripts from the script repository on the UCCX server and to generate the script 

documentation as PNG images, the Cisco UCCX Script Editor must be installed on the same machine as the Report Tool. 

Please verify that the Cisco UCCX Script Editor works and can access the script repository on the UCCX server. If the Cisco 

UCCX Script Editor is not available, the report will contain the co nfiguration of the UCCX administration pages. 

MICROSOFT EXCHANGE (UNIFIED MESSAGING) 2007 R2 AND 2010 

Generating reports for Microsoft Exchange (Unified Messaging objects and users) versions 2007 R2 and 2010 is now available 

starting with Uplinx Report Too l version 8.5. 

Reports for Microsoft Exchange versions 2007 R2 and 2010 contain the following:  

¶ Configuration reports of the Unified Messaging role and users with voicemail 

¶ Exchange reports have been included to fully document a Cisco telephony system which uses Microsoft Exchange 

for voicemail. This is to complement the reports for Cisco.  

Note: This is not intended to document Unity with Exchange. It is intended to document Microsoft Exchange with the Unified 

Messaging role installed for voicemail in Exchange. 

Requirements:  

Access to Active Directory Domain and óreadô privileges to the Unified Messaging role and user objects. 
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STEP 2: SET REPORT FORMAT  

 

Figure 2: Set the report settings like report title, description, style and other options. 

In the group box ΨwŜǇƻǊǘ {ŜǘǘƛƴƎǎΩ set the following: 

¶ ¢ƘŜ ΨwŜǇƻǊǘ CƻǊΩ ǘŜȄǘ ŦƛŜƭŘΥ ¢Ƙƛǎ ǿƛƭƭ ōŜ ǳǎŜŘ ƛƴ ǘƘŜ ǘƛǘƭŜ ŀƴŘ ŦƛƭŜƴŀƳŜ ƻŦ ǘƘŜ ǊŜǇƻǊǘΦ You may wish to use the 

ŎǳǎǘƻƳŜǊΩǎ company name, and/or the purpose of ǘƘŜ ǊŜǇƻǊǘΦ CƻǊ ŜȄŀƳǇƭŜΥ Ψ!ǳŘƛǘ ŦƻǊ ¦ǇƭƛƴȄ tǘȅ [ǘŘΦΩ 

¶ ¢ƘŜ Ψ5ŜǎŎǊƛǇǘƛƻƴΤ ǘŜȄǘ ŦƛŜƭŘΥ ¢Ƙƛǎ ǿƛƭƭ ōŜ ǇƭŀŎŜŘ ōŜƭƻǿ ǘƘŜ ǘƛǘƭŜ ƛƴ ǘƘŜ ƎŜƴŜǊŀǘŜŘ ǊŜǇƻǊǘ ŀƴŘ ǎƘƻǳƭŘ ŘŜǎŎǊƛōŜ ŘŜǘŀƛƭǎ ƻŦ 

the author or source of the report. For example: created on 27 July 2010 by Michael K. 

In the group box ΨReporǘ CƻǊƳŀǘΩ ǎŜǘ ǘƘŜ Ψ{ǘȅƭŜ ŀƴŘ tŀƎŜ CƻǊƳŀǘΩ: 

o ΨwŜǇƻǊǘ {ǘȅƭŜΩΥ ¢Ƙƛǎ ǎŜƭŜŎǘǎ ǘƘŜ /{{ ό{ǘȅƭŜ ǎƘŜŜǘύ ŀƴŘ ŘŜǘŜǊƳƛƴŜǎ ǘƘŜ ǎǘȅƭŜ ƻŦ ǘƘŜ ǊŜǇƻǊǘΦ 

o Page Format: A4 or Letter. You should modify the Word template if you choose Letter. 
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Á Page Settings: Set the border of the pages: 

 

o Templates: Set a HTML and WORD template for each reportΦ ¢ƘŜ άDŜƴŜǊŀǘŜ ¢Ŝǎǘ wŜǇƻǊǘέ ƎŜƴŜǊŀǘŜǎ ŀ 

sample report to test and preview the template without requiring a server.  

 

Figure 3: Select the Template for each report 

In the group box ΨwŜǇƻǊǘ CƻǊƳŀǘΩ ǎŜǘ ǘƘŜ ΨReport Generation Settings: 

¶ (Optional) Additional settings: 

o Floating TOC for WEB:  Ticking this tab will generate a navigation strip on the right side of the generated 

web report for easy navigation. Recommended: Enable. 

o Create compressed CHM report: Creates a CHM (Compressed HTML Help) file when the report is 

generated. Recommended: Enable. 

o Add descriptions to the report. When ticked, this option adds a descriptive text to each object in the 

report. To customize this ǘŜȄǘΣ ǇƭŜŀǎŜ ǊŜŦŜǊ ǘƻ ǘƘŜ ǎŜŎǘƛƻƴ ƻƴ ά/ǳǎǘƻƳƛȊŀǘƛƻƴέΦ wŜŎƻƳƳŜƴŘŜŘΥ 9ƴŀōƭŜΦ 

o Ψ¦ǎŜ ¸b ƛƴǎǘŜŀŘ ƻŦ ǘƛŎƪ ōƻȄŜǎΩ 

In the group box ΨwŜǇƻǊǘ CƻǊƳŀǘΩ ǎŜǘ ǘƘŜ ΨReport Generation SettingsΩΥ 
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Lƴ ǘƘŜ ƎǊƻǳǇ ōƻȄŜǎ ΨtǊŜǎŜƴǘŜǊΩ ŀƴŘ Ψ/ƭƛŜƴǘ LƴŦƻǊƳŀǘƛƻƴΩ ȅƻǳ Ŏŀƴ ǎŜǘ ȅƻǳǊ ŀƴŘ Ŏlient information as it is displayed in 

the Document Information section of the word or HTML document. When the tick boxes of these 2 sections are not 

selected, the document information section will not appear in the reports. 

To customize report templates, please refer to ΨCustomizing your own templatesΩ ƻƴ ǇΦ 39. 
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STEP 3: SET REPORT CONTENT 

To define the Report content ( i.e. objects to be included in the report) and additional settings (i.e. condensed or detailed format) , 

follow these steps: 

1. On the óGenerate Reportô tab, select a report content profile or add or update one by clicking the cog icon in the Report 

Content Profile group box. 

 

2.  To include an object in the report tick the object in the object tree. (to include/excl ude a tree and its children objects ï 

tick/untick a folder heading)  

3. After selecting a server object, the description and additional settings (Condensed or Detailed format) and filters can be se t. 

Please consider the following: 

¶ For Word document format : a system with 400 phones will produce a report that is approximately 400 pages in length.  To 

reduce the number of pages, split the report into several parts by selecting only the following objects:  

¶  

o Users (Detailed / Condensed settings) 

o Phones ï please see filter options in Step 3.1 

o User Device Profiles 

o All other settings 

Defer the Word formatting by selecting the óNoô button when the Word dialog appears. 

¶ Generate the HTML and CHM report on site (select the óCancelô button when the Word dialog appears) and manually 

generate the Word report. To manually generate the Word report , please see section ñLarge Word reportsò on p.37. 
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To update the Command Line commands to be included in the report, please see άAttachment D: Updating or adding CLI 

commands in Reportsέ ƻƴ ǇŀƎŜ 59.
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STEP 3.1: FILTER OPTIONS FOR PHONES 

To include a subset of phones in the configuration report, a filter can be defi ned in  

ñGenerate Report > Select Report Content Profile > CUCM_version > Phone > Phone > Filter tabò.  

One or several filter criteriaôs can be added and saved. If the CUCM server credentials have been already defined in the server tab, the 

óPreviewô button shows the result of the filter  by querying CUCM. Individual phones can be selected by ticking the include tick  box and 

pressing óAdd selected items to filterô: 
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STEP 4: GENERATE THE REPORT 

¢ƻ ƎŜƴŜǊŀǘŜ ǘƘŜ ǊŜǇƻǊǘΣ ŎƭƛŎƪ ǘƘŜ DŜƴŜǊŀǘŜ ōǳǘǘƻƴ ƛƴ ǘƘŜ ΨDŜƴŜǊŀǘŜ wŜǇƻǊǘΩ ōǳǘǘƻƴΦ .ŜŦƻǊŜ Řƻing so, please make sure that 

ȅƻǳ ƘŀǾŜ ŎƻƴƴŜŎǘƛǾƛǘȅ ǘƻ ǘƘŜ ǎŜǊǾŜǊ ōȅ ǳǎƛƴƎ ǘƘŜ ά±ŀƭƛŘŀǘŜ /ǊŜŘŜƴǘƛŀƭǎΩ ōǳǘǘƻƴ ƛƴ ǘƘŜ Ψ{ŜǊǾŜǊΩ ǘŀōΦ 
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STEP 5 (ONLY FOR UCCX): INCLUDING UCCX SCRIPTS IN REPORTS 

This step only applies to reports for Cisco UCCX. 

To download the UCCX scripts (.aef) scripts from the script repository on the UCCX server and to generate the script 

documentation as PNG images, the Cisco UCCX Script Editor must be installed on the same machine as the Report Tool. 

Please ǎŜŜ Ψ¦//· ǊŜǉǳƛǊŜƳŜƴǘǎΩ ƻƴ ǇŀƎŜ тΦ 

 

¢ƻ ƛƴŎƭǳŘŜ ǊŜǇƻǊǘǎ ŀōƻǳǘ ¦//· ǎŎǊƛǇǘ ŦƛƭŜǎΣ ǘƘŜ Ψ{ŎǊƛǇǘ !ŜŦ 

CƛƭŜǎΩ ƻōƧŜŎǘ Ƴǳǎǘ ōŜ ǎŜƭŜŎǘŜŘ ƛƴ ǘƘŜ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ǘǊŜŜΦ 

Please make sure before running the report, that the correct 

version of Cisco UCCX Editor is installed and the repository 

can be accessed on the server. 

 

During the UCCX report generation, the following login will be presented. A successful login is required to retrieve all scripts 

and include into the generated report.  
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All aef script files and its imŀƎŜǎ ŀǊŜ ŎƻǇƛŜŘ ŦǊƻƳ ǘƘŜ ¦//· ǎŎǊƛǇǘ ǊŜǇƻǎƛǘƻǊȅ ǘƻ ǘƘŜ ŘƛǊŜŎǘƻǊȅ ΨhǳǘǇǳǘ 5ƛǊŜŎǘƻǊȅ ƻŦ wŜǇƻǊǘǎΩ  

Ǉƭǳǎ  ά\screenshots\  άΦ Lǘ Ƙŀǎ ǘƘŜ ǎŀƳŜ ŘƛǊŜŎǘƻǊȅ ǎǘǊǳŎǘǳǊŜ ŀǎ ƛƴ ǘƘŜ ¦//· ǎŎǊƛǇǘ ǊŜǇƻǎƛǘƻǊȅΦ 

 

NOTE: GENERATING CUCM REPORTS DURING BUSINESS HOURS 

During CUCM report generation AXL SOAP requests are sent to the Publisher, which processes the requests and sends back 

requested data to the Report Tool. These requests are throttled to reduce the impact on the PublisherΩǎ performance. 

Based on our experience the CPU load on the publisher increases by 10% during report generation. So, if the CPU is about 

20% on a publisher during normal operations, the report generation increases the CPU load to 30%. This has no business 

impact. 

If the average CPU level is above 30% on the Publisher (which we have hardly seen on a CUCM cluster in versions 5 to 8), it is 

recommended that reports be generated outside of business hours. 

 

PROFILES 

Report Tool version 8.6.6 (5 Sept 2011) added new features for customer profiles and content profiles. 

Customer Profile: 

Customer profiles store all settings and are displayed in a combo box in the header of the Report Tool form: 

 

 It includes server, presenter and client info, report format settings and report content profiles. Typically, profiles would be 

ŎŀƭƭŜŘ ŀŎŎƻǊŘƛƴƎ ǘƻ ǘƘŜ ŎǳǎǘƻƳŜǊ ƴŀƳŜΣ ŦƻǊ ŜȄŀƳǇƭŜ ά/ǳǎǘƻƳŜǊ !έΣ ά/ǳǎǘƻƳŜǊ .έΦ ¢ƻ ŎǊŜŀǘŜ ŀ ƴŜǿ ǇǊƻŦƛƭŜΣ ǎƛƳǇƭȅ ŎƻǇȅ ŀƴ 

existing profile, provide a new customer profile name and modify its settings. 

Content Profile: 

One or several content profiles are contained within a customer profile. It defines which server objects are included in the 

generated report and its settings [condensed, detailed both].   
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Typically, the following content profiles are recommended for a large deployment: 

¶ System Settings 

¶ Phones 

¶ Device Profiles 

¶ Users 

¶ Gateways 

It can be copied, updated or deleted on the Report Tool > Generate tab.  

The content profile is selected after a Customer Profile has been selected and before the report generation is started. The 

last selected content profile is saved as the active content profile within the customer profile and used for report generation.  

Command Line:  

In previous releases, Report Tool settings had to be managed in the Windows File Manager. Now, customer profiles can be 

added, updated or deleted directly within the Report Tool GUI. 

hƴ ǘƘŜ ŎƻƳƳŀƴŘ ƭƛƴŜΣ ƴƻǘƘƛƴƎ ŎƘŀƴƎŜǎΤ ǘƘŜ ŎǳǎǘƻƳŜǊ ǇǊƻŦƛƭŜ ƴŀƳŜ Ŏŀƴ ōŜ ƻǇǘƛƻƴŀƭƭȅ ǎǇŜŎƛŦƛŜŘ ƛƴ ǘƘŜ ǇǊƻŦƛƭŜ ƻǇǘƛƻƴ άκŎέΦ 

Settings of a specific customer profile are loaded with the switch: /config ( or /c )  <Customer Profile file name>. If this 

switch is not given, the settings of the last active customer profile will be loaded. 

Please refer to ǎŜŎǘƛƻƴ ΨUsing Customer ProfilesΩ ƻŦ Ψ/ƻƳƳŀƴŘ [ƛƴŜΨƻƴ p. 45 for more details. 
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PHONE INVENTORY REPORTS 

The phone inventory report is used to gather phone asset information  for inventory or asset management.  

The phone inventory report is generated in 3 formats (Word, CSV, Excel) which contain the following info rmation:  

Word (DOC) report  

The Word report contains the phone status *  information (see below) per phone and phone configuration settings which can be 

defined in the óFields includedô section of the Phone Inventory settings. The phones are sorted per model. 

CSV report  

The CSV report contains the phone status *  information (see below) per phone and all phone configuration settings which appear in 

the óFields includedô section of the Phone Inventory settings. The Excel report supersedes this report. 

Excel ( XLS) report  

The following worksheets (tabs) are available in the report:  

¶ Actions: Contains a button which starts a VBA macro to generate the tab óPhone Statistics per Device Poolô. This macro can 

be modified to your needs for billing or asset reporting. It  summarizes information from the other tabs.  

¶ PhoneStats per DP: Phone Statistics per Device Pool. (press button "Generate Phone Stats per Device Pool" first) 

¶ Summary: Statistics of the retrieved phones  per model 

¶ Phones: Contains the phone status *  information (see below) per phone and all phone configuration settings which appear 

in the óFields includedô section of the Phone Inventory settings. This is the same information as in the CSV. 

¶ Registration: Contains the phone status *  information (see below) pe r phone 

¶ Configuration: Contains configuration information of each phone. Multiple lines (extension) will create multiple records.  

¶ Phone Extension: This is the same as Configuration tab but multiple lines (extension) appear in one record. A maximum of 

255 columns can be included which is sufficient for the phone configuration and up to 16 extensions per phone.  

¶ Subscribed IP Phone services  

¶ Speed Dial of each phone 

¶ BLF Speed Dial of each phone 

¶ BLF Call Park of each phone 

Please note that if a filter has been used, above tabs contain the matches of the filter (that means that statistics and summary 

information is only for the matches).  

* ) Phone Status contains for each phone: 

¶ Phone Name 

¶ IP of phone (if registered)  

¶ Registration Status 

¶ IP of CCM registered to 

¶ Timestamp  

¶ Login UserID (Extension Mobility user which is logged in) ï if empty nobody is logged in  

¶ Serial Number 

¶ Hardware revision 

¶ Software version 

¶ MWI status (on/off)  

¶ CDP Neighbour Name, Neighbour IP, Neighbor port 

¶ PC port info 

¶ Extension Module (Product, serial, version) 
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The phone status contains information from the CUCM database and CUCM RIS (Realtime Information Service), the serial, 

and other phone information are retrieved from the phone web page.  

The comparison (audit) function  allows comparing 2 Excel phone inventory reports to show any registration or configuration 

change. It contains the following tabs in the generated Excel spreadsheet:  

¶ ñSummaryò tab with amount of added and deleted phones, changed registration status and changes in configuration 

¶ ñDetailsò tab with all changes highlighted. Red are changes to existing or deleted phones. Green are newly added phones 

¶ ñNew Configuredò tab: Phones which have been added to CUCM configuration 

¶ ñNew Registeredò tab: Phones which are now registered but have not been registered before 

¶ ñUnregisteredò tab: Phones which are now not registered but have been registered before 

¶ ñDeletedò tab: Phones which have been deleted from CUCM configuration 

¶ ñConfiguration Changesò tab: Phones which have been changed in the CUCM configuration 

Phone inventory reports and comparison (audit) reports can be easily executed from the command line and also scripted in any script 

language. Please see CLI - Command Line Interface.  

 

HOW TO GENERATE A PHONE INVENTORY REPORT 

A report is generated in 4 steps: 

¶ Step 1: Set the access credentials to the server and verify connectivity 

¶ Step 2: Set the desired report format  

¶ Step 3: Define the report content  

¶ Step 4: Generate the report  

Each of the steps is outlined in detail below. 

STEP 1: SET CUCM ACCESS CREDENTIALS AND VERIFY CONNECTIVITY 
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NOTE:  

¶ In order to generate Phone Inventory Reports, the CUCM application user must be a member of the group 

Ψ{ǘŀƴŘŀǊŘ //a !ŘƳƛƴ ¦ǎŜǊǎΩ. This is required by CISCO to access the RIS component. If this is not the case a 403 error 

(access forbidden) will occur. 

¶ AXL must be enabled 

¶ The HTTP server on the phones must be enabled to retrieve the serial number of phones and extension modules. 

¶ If CDP is enabled on the switches the neighbor port details will be available 
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STEP 2: SET REPORT FORMAT  

 

Figure 4: Set the report settings like report title, description, style and other options. 

Lƴ ǘƘŜ ƎǊƻǳǇ ōƻȄ ΨwŜǇƻǊǘ {ŜǘǘƛƴƎǎΩ set the following: 

¶ ¢ƘŜ ΨwŜǇƻǊǘ CƻǊΩ ǘŜȄǘ Ŧield: This will be used in the title and filename of the report. You may wish to use the 

ŎǳǎǘƻƳŜǊΩǎ ŎƻƳǇŀƴȅ ƴŀƳŜΣ ŀƴŘκƻǊ ǘƘŜ ǇǳǊǇƻǎŜ ƻŦ ǘƘŜ ǊŜǇƻǊǘΦ CƻǊ ŜȄŀƳǇƭŜΥ Ψ!ǳŘƛǘ ŦƻǊ ¦ǇƭƛƴȄ tǘȅ [ǘŘΦΩ 

¶ ¢ƘŜ Ψ5ŜǎŎǊƛǇǘƛƻƴΤ ǘŜȄǘ ŦƛŜƭŘΥ ¢Ƙƛǎ ǿƛƭƭ ōŜ ǇƭŀŎŜŘ ōŜƭƻǿ ǘƘŜ ǘƛǘƭŜ ƛn the generated report and should describe details of 

the author or source of the report. For example: created on 27 July 2010 by Michael K. 

Lƴ ǘƘŜ ƎǊƻǳǇ ōƻȄ ΨwŜǇƻǊǘ CƻǊƳŀǘΩ ǎŜǘ ǘƘŜ Ψ{ǘȅƭŜ ŀƴŘ tŀƎŜ CƻǊƳŀǘΩ: 

o ΨwŜǇƻǊǘ {ǘȅƭŜΩΥ ¢Ƙƛǎ ǎŜƭŜŎǘǎ ǘƘŜ /{{ ό{ǘȅƭŜ ǎƘŜŜǘ) and determines the style of the report. 

o Page Format: A4 or Letter. Please select a matching Word template which has been designed for this page 

format. 
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Á Page Settings: Set the border of the pages: 

 

o Templates: Set a HTML and WORD template for each report. ¢ƘŜ άDŜƴŜǊŀǘŜ ¢Ŝǎǘ wŜǇƻǊǘέ ƎŜƴŜǊŀǘŜǎ ŀ 

sample report to test and preview the template without requiring a server.  

 

Figure 5: Select the Template for each report 

In the group box ΨwŜǇƻǊǘ CƻǊƳŀǘΩ ǎŜǘ ǘƘŜ ΨReport Generation Settings: 

¶ (Optional) Additional settings: 

o Floating TOC for WEB:  Ticking this tab will generate a navigation strip on the right side of the generated 

web report for easy navigation. Recommended: Enable. 

o Create compressed CHM report: Creates a CHM (Compressed HTML Help) file when the report is 

generated. Recommended: Enable. 

o Add descriptions to the report. When ticked, this option adds a descriptive text to each object in the 

ǊŜǇƻǊǘΦ ¢ƻ ŎǳǎǘƻƳƛȊŜ ǘƘƛǎ ǘŜȄǘΣ ǇƭŜŀǎŜ ǊŜŦŜǊ ǘƻ ǘƘŜ ǎŜŎǘƛƻƴ ƻƴ ά/ǳǎǘƻƳƛȊŀǘƛƻƴέΦ wŜŎƻƳƳŜƴŘŜd: Enable. 

o Ψ¦ǎŜ ¸b ƛƴǎǘŜŀŘ ƻŦ ǘƛŎƪ ōƻȄŜǎΩ in Word as tick boxes are not correctly displayed in large Word reports 

In the group box ΨwŜǇƻǊǘ CƻǊƳŀǘΩ ǎŜǘ ǘƘŜ ΨReport Generation SettingsΩΥ 

Lƴ ǘƘŜ ƎǊƻǳǇ ōƻȄŜǎ ΨtǊŜǎŜƴǘŜǊΩ ŀƴŘ Ψ/ƭƛŜƴǘ LƴŦƻǊƳŀǘƛƻƴΩ ȅƻǳ Ŏŀƴ ǎŜǘ ȅƻǳr and client information as it is displayed in 

the Document Information section of the word or HTML document. When the tick boxes of these 2 sections are not 

selected, the document information section will not appear in the reports. 
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To customize report teƳǇƭŀǘŜǎΣ ǇƭŜŀǎŜ ǊŜŦŜǊ ǘƻ Ψ/ǳǎǘƻƳƛȊƛƴƎ ȅƻǳǊ ƻǿƴ ǘŜƳǇƭŀǘŜǎΩ ƻƴ ǇΦ 39. 

Note: If you are only interested in the Comma Separated file (CSV) or Excel format with all data, you might want to disable 

the word generation:  

 

STEP 3: SET REPORT CONTENT 

To define the Phone Inventory content please use the settings in the group box ñContent and options for Phone Inventory Reportò on 

tab óPhone Inventoryô: 

 

Include detailed Phone Configuration:  Include detailed phone and line configuration  in the Excel report. Excel report must be also 

enabled in 'Report Settings'. If this is disabled, the phone registration status with basic configuration items are included.  

Recommended: Enabled. 

Include Configuration for Services, SD, BLF and CallPark per  phone:  Include Services, ShortDials, BLF and Callpark 

configuration per phone in the Excel report. Excel report must be also enabled in 'Report Settings'. If this is disabled, the se 

configuration items are included. Recommended: Enabled. 

Ping phones to te st connectivity:  If ticked, Report Tool will test reachability to a phone with a ping before retrieving information 

from the phone web pages. In most cases, it is recommended to have this option enabled. Disable this option if you have a web proxy 

or a fir ewall between the Report Tool and the phones. 
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Automatic User Locale detection:  If ticked, the automatic international user locale support is enabled. If not ticket, the user locale 

english will be forced. In most cases it is recommended to have it enabled. 

Retrieve phone data with concurrent threads:  If ticked, several threads will be used to retrieve data concurrently from phones. 

This will be faster. If not ticket, phone information will be retrieved one by one. It is recommended to enable this option.  

FIELDS INCLUDED: 

Fields included define which columns are included in the HTML and Word report. All fields  are included in the Excel and CSV 

report  except the PC port . For performance reasons the PC port is excluded by default. 

 

¶ Each added field will add a column to the HTML and Word report. If many columns are selected, not all columns might fit to 

the Word page and content might appear squeezed. 

PHONE FILTER: 

The phone filter defines which objects are included in the report. It allows filtering by: 

¶ Device Name 

¶ Phone description 

¶ Model 

¶ Device Pool 

¶ First extension 

¶ Location 
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The preview button  will list the matching phones by querying the server. This is limited to a maximum of 2000 

entries. 

Individual or a list of  phones can then be added to the filter. I ndividual phones are added from the search panel to the report by 

checking the include tick box of one or several phones and by pressing . This is limited to max 200 

phones. 

 

A list of phones (CSV separated or one phone per line) can be imported as filter by pressing  and selecting the file. 

This is limited to a maximum of 200 phones.  

RETRIEVAL SETTINGS 
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The following settings will influence the retrieval process. Recommended defaults are shown above: 

¶ ñPing phones to test connectivityò: This will ping a phone to verify connectivity. In networks with poor connectivity this will 

improve the total reporting time as ping timeouts require less time than HTTP timeouts. 

¶ ñAutomatic User Locale detectionò: This will use information from CUCM in the field ñUser Localeò to determine the language 

of the phone web pages. It is recommended to have this setting enabled. You might disable this if there are no other user 

locales than US English installed on CUCM. 

¶ ñRetrieve phone data with concurrent threadsò: If ticked, several threads will ce used concurrently to retrieve data from 

phones. This will be faster. If not ticket, phone information will be retrieved one by one  and report generation will take 

longer. It is recommended to enable this option unless there are issues  experienced. 

STEP 4: GENERATE THE REPORT 

¢ƻ ƎŜƴŜǊŀǘŜ ǘƘŜ ǊŜǇƻǊǘΣ ŎƭƛŎƪ ǘƘŜ DŜƴŜǊŀǘŜ ōǳǘǘƻƴ ƛƴ ǘƘŜ ΨDŜƴŜǊŀǘŜ wŜǇƻǊǘΩ ōǳǘǘƻƴΦ .ŜŦƻǊŜ ŘƻƛƴƎ ǎƻΣ ǇƭŜŀǎŜ ƳŀƪŜ ǎǳǊŜ ǘƘŀǘ 

ȅƻǳ ƘŀǾŜ ŎƻƴƴŜŎǘƛǾƛǘȅ ǘƻ ǘƘŜ ǎŜǊǾŜǊ ōȅ ǳǎƛƴƎ ǘƘŜ ά±ŀƭƛŘŀǘŜ /ǊŜŘŜƴǘƛŀƭǎΩ ōǳǘǘƻƴ ƛƴ ǘƘŜ Ψ{ŜǊǾŜǊΩ ǘŀōΦ 
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COMPARISON (AUDIT) OF REPORTS 

The following 2 comparison (audit) reports are included : 

¶ Comparison (audit) of CUCM configuration reports 

¶ Comparison (audit) of phone inventory reports  

The comparison requires 2 reports generated by the Report Tool which are compared and show the differences in the generated 

comparison report. The comparison report is started from the ñAudit Reportò tab and can be also run from the command line. 

 

COMPARISON (AUDIT) OF CUCM CONFIGURATION REPORTS 

The CUCM configuration comparison requires 2 HTML reports generated by the Report Tool which are compared and show the 

differences in the generated comparison report. The generated comparison report is rendered in HTML and Word format and shows: 

¶ Added and deleted records 

¶ Changed fields per record 

It is structured per CUCM report object.  

To generate the report, enter a base report (that is the older report) and a newer revised or changed report as input. Then p ress the 

ñCompareò button. To interactively select compared objects in the generated comparison report, tick ñAdvanced Modeò in Settings. 
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The Report Comparison feature generates a differential report from an original base report and a revised configuration report . This 

feature only works for CUCM configuration reports. I n the future it will be extended for CUPS and CUC reports. 

¶ To generate a differential report, an original base report and a separate revised report are required as input. The base and 

the revised reports must have been generated using the same version of t he Report Tool. To generate the differential report, 

select the input file and output file names. The output report will be generated in HTML and Word document format.  

¶ Select the 'Comparison' and 'Report Output' settings before generating a differential re port by clicking the 'Compare' button. 

Moving the mouse over the settings tab provides more detailed information and help.  

¶ Note: The demo version will not generate accurate differential results as the input records do not contain all required 

information. The demo is only intended for illustrative purposes.  

COMPARISON (AUDIT) OF PHONE INVENTORY REPORTS 

The Phone Inventory comparison requires 2 Excel reports generated by the Report Tool which are compared and show the differences 

in the generated comparison report. The generated comparison report is rendered in Excel and shows: 

¶ Added and deleted phones in CUCM configuration 

¶ Registered and unregistered phones 

¶ Changes in phone configuration and lines 

Please note that configuration changes to phones, lines, Speed Dials, BLF and subscribed IP Phone services and other CUCM 

configuration objects can be seen in the CUCM comparison (audit) report. 

To generate the report, enter a n Excel base report (that is the older report) and a newer revised or changed report as inp ut. Then 

press the ñCompareò button. The tick box   will include the RIS timestamp in the comparison. Typically, if a phone re 

registers to CUCM the RIS timestamp is set. If you are only interested in the current registration status (or phones have re registered) 

the  should not be ticked to exclude this value from the comparison algorithm.  
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TROUBLESHOOT WORD REPORT ISSUES 

WORD 2007 CRASHES  

Please make sure that Word 2007 SP2 is installed from: 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b444bf18 -79ea-46c6-8a81-9db49b4ab6e5 

WORD PROBLEM WHEN NO USERNAME IS SET  

Symptom: The Report Tool fails to generate the Word report even if  VBA support is installed 

Please check that a user name is set. To do this, click the óMicrosoft Office Buttonô, click óWord Optionsô >> Personalize your copy of 

Microsoft Office >> enter a user name and initials, and then click óOKô. 

For the non OEM version: click the óMicrosoft Office Buttonô, click óWord Optionsô >> Popular then "Personalize your copy of Microsoft 

Office". 

 

This is further documented in: http://kbalertz.com/948682/Error -message-command-Immediate-window-Visual-Basic-Error.aspx 

LARGE WORD REPORTS 

The Word format report might have an issue if its length is more than 250 pages. Please note that th is is not a Report Tool issue. 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b444bf18-79ea-46c6-8a81-9db49b4ab6e5
http://kbalertz.com/948682/Error-message-command-Immediate-window-Visual-Basic-Error.aspx
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There is a problem with large Word reports when:  

1. The HTML/CHM report has been generated properly 

2. Word report generation fails  

3. The test word report succeeds. A test report can be generated by clicking óTest Report Styleô on the óReport 

Settingsô tab.   

To avoid potential issues with large Word reports, try one of the following:  

1. Generate smaller, separate reports using automatic Word generation and include only some objects within each report.. For 

example, instead of one large report, generate four separate repor ts for: (i) Phones; (ii) Users in detailed user mode; (iii) Device 

Profiles; and (iv)  System settings.  

2. Generate one large HTML report by disabling automatic Word generation in the options. Manually import the HTML file into 

the Word template and split  the HTML file before importing it.  

To manually import the HTML file:  

1. Open the Word template in the folder C: \Program Files\ReportTool_7x\ templates\<report_Type> \word\A4 or 

Letter\ template_name.doc 

2. Go to the section where it says #BODY#, delete this tag #BODY# and place the cursor there.  

3. In the Word 2007 menu: Insert > Object > Insert from File import the HTML file. Click on the óFormatô button on the first 

page to reformat and adjust the content. Doing this will run some VBA macros to format the f ile.  

If this doesnôt work and an error message pops up ï please email screenshot/google/adjust Word VBA scripts (if you do that we would 

love to hear what you did to improve the report tool further).  

MANUALLY GENERATING A WORD REPORT FROM A HTML REPORT 

After a HTML report has been generated, a Word report can be generated from the HTML report in the following way:  

1. Open the Word document in the folde r C:\Program Files\ReportTool\ templates\<report_type> \word\<template> .doc 

2. Go to the section where it says #BODY#, delete this tag (ñ#BODY#ò) and place the cursor there. 

3. In the Word 2007 menu  ñInsert > Object > Text from Fileò  and select the generated HTML report. This will insert the HTML 

report into the word document and may take several minutes.  

 
Click on the ñFormatò button on the first page to reformat and adjust the content. That will run some VBA macros and 

format the word report. This might take several minutes, depending on the size of the HTML file.  

 

4. Save the report in the desired format, alter or prin t to PDF. (CutePDF is a free, excellent PDF converter). For Word there is 

an add-in to Word 2007 available from Microsoft called ñ2007 Microsoft Office Add-in: Microsoft Save as PDFò. It 

produces smaller PDF files than the CutePDF option. 

You might note th at check boxes are not properly displayed in Word . This is a known Word problem which is related to the size 

of the report and to available memory. It displays as:  
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There is no fix once the report has been generated. There is an option in the Report Tool settings, which need to be set before the 

report is generated. It replaces the check boxes with the letters Y or N in the HTML generated code before importing it into Word. The 

setting is in Report Settings > Report Generation Settings:  

 

CUSTOMISING YOUR OWN REPORT TEMPLATES 

'Report Tool for Cisco Unified Communications' is template based for the  generation of HTML, Word and CHM reports. The template 

based approach allows for the following branding options:  

¶ Quickly generate reports based on your own company templates 

¶ Use your companyôs color scheme, header and footer  format and page layouts 

¶ Use your own logo and front page 

¶ Watermark pages 

¶ Protect reports with secure PDF 

Please modify the templates to suit your needs. The following Report Templates are currently by default included:  



User Guide and Release Notes ς Uplinx ® Report Tool for Cisco Unified Communications 

 

Copyright © 2008 - 2012 Uplinx-Software Pty Ltd   Page 40 of 76 

 

40 

 

Word templates are located in the folder:  

C:\Program Files\ReportTool\ templates\<report_Type> \word\A4 or Letter\ 

 

Figure 6: TeƳǇƭŀǘŜ ά.ŀǊǎψtƘƻƴŜǎψDǊŜŜƴψ.ƭǳŜΦŘƻŎέ 
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Figure 7: TŜƳǇƭŀǘŜ ά{ǉǳŀǊŜǎψwƛƎƘǘ{ƛŘŜōŀǊψDǊŜȅΦŘƻŎέ 

 

Figure 8: Template "Tiles_LeftBorder_Grey.doc" 








































































